Imaging and Analyzing Southern California’s Active Faults with High-Resolution Lidar Topography
A joint SCEC/OpenTopography/UC Davis Keck Caves Short Course

Exercise 1: Basic visualization of LiDAR Digital Elevation Models using
ArcGIS

Introduction

This exercise covers activities associated with basic visualization of LiDAR Digital Elevation
Models using ArcGIS. Topics include a description of the standard tiled DEMs available from
http://www.opentopography.org, loading them into ArcMap and mosaicking them, and producing
color gradient maps, hillshades, slope maps and slopeshades, and contour maps.

Data included

We start with the uncompressed downloaded archives from http://www.opentopography.org ->
Standard DEMs.

The DEMs in this example are for Sanborn Park area in the Santa Cruz Mountains, California
(archive names are 583 4120, 583 4121, 582 4120 and 582 4121).

Data Data Resolution Coordinate System
format (m)
GeoEarthScope Lidar data ArcGrid 0.5 UTM Zone 10N, WGS84
tiles—unfiltered (all the data) ellipsoid heights

and filtered (just ground
returns) interpolated by kriging
to make DEM. Includes
hillshades

Data source, type, and file naming convention

OpenTopography delivers the Standard DEMs as delivered from the National Center for Airborne
Laser Mapping (http://www.ncalm.org/). In this demonstration, we will play with the filtered and
unfiltered 1km x 1km Arclnfo grids @ 0.5m cell size and their shaded relief maps (NO overlap).

Due to Arclnfo file naming limitations, the grids contain only the significant digits from the lower
left coordinate of their originating tile. For example, the ASCII tile named

“f571000 4130000.xyz” corresponds to the ArcInfo elevation grid named “fg571 4130 and
shaded relief map “fg571 4130shd”. Filtered elevation grids are prefixed by “fg” and the
hillshades end in “shd”. Unfiltered elevation grids are prefixed by “ug” and the hillshades end in
“shd.”

ArcGIS activities

Introduction

The ArcGIS software suite has many useful capabilities for handling geospatial data including
LiDAR DEMs. We use ArcMap 9.3 (with its extensions Spatial Analyst and 3D Analyst) to
produce map view visualizations. For some introductory lessons in ArcGIS, you should check the
ESRI web sites (http://www.esri.com/ and http://www.esri.com/what-is-gis/index.html) and you
may also try Ramon’s lectures at http://arrowsmith410-598.asu.edu/GLG410_598--Lectures.html.
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Launch ArcMap and load data

Under the Start Menu, navigate to ArcGIS and launch ArcMap. Once the software is launched,
you can click on the yellow plus to add the DEMs:
% . Untitled - ArcMap - Arcdinfo

File Edit View Bookmarks Insert Selection Tools Window Help

DS E& BX |0 > | RRIAr L A=R-2 v

=] Loyers| T

Note that the first time you navigate for the data, you may need to “Connect to the folder”
and navigate to where they are located:

Add Data I&I
Look in: | EJ Catalog LI o | Ql ; | rrrrr EEE % gg
R
E‘C:\ L@g GIS Serve| Connect To Folder

Mosaicking the DEM tiles

Before adding too many files, let’s mosaic the 4 contiguous square kilometer tiles that we

downloaded. For this, you need to open up the ArcToolbox (red toolbox symbol):
% . Untitled - ArcMap - Arcnfo

File Edit View Bookmarks Insert Selection Tools Window Help

beEd&E - BX | o & MRIAr R M= -2 Y

=] Loyers I
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% Untitled - ArcMap - Ardnfo

File Edit View Bookmarks Insert Selection Tools Window Help

DEeE& BX |0 > |d |24 &% A ¥

m =)- & Data Management Tools B

& Data Comparison

& Database

& Disconnected Editing

& Distributed Geodatabase

& Domains

& Feature Class

& Features

& Fields

& File Geodatabase

& General

& Generalization

& Indexes

& Joins

& Layers and Table Views

& Projections and Transformatior|

=] & Raster

@ Raster Catalog
= @ Raster Dataset

#* Copy Raster
A Create Random Raster
A Create Raster Dataset
A Mosaic

>
P .3 Mosaic To New Raster

m

%= Mosaic To New Raster

Input Rasters

Output Location

C:\Users\ramon\Desktop\temp\Projects\SCEC\Workshop \Exercise 2Tutorial\582_4120...
C:\Users\ramon\Desktop\temp\Projects\SCEC\Workshop \Exercise 2Tutorial\582_4121...
C:\Users\ramon\Desktop\temp\Projects\SCEC\Workshop \Exercise 2Tutorial\583_4120...
C:\Users\ramon\Desktop\temp\Projects\SCEC\Workshop \Exercise 2Tutorial\583_4121...

I C:\Users\ramon\Desktop\temp\Projects\SCEC\Workshop \Exercise 2Tutorial
Raster dataset name with extension

&[> [X |+ &

&

I fullmos
Coordinate system for the raster (optional)

| wes_1984_UTM_zone_10n
Pixel type (optional)

| 32_BIT_FLOAT
Cellsize (optional)

I« (@]

Number of bands

Mosaic Method (optional)

-

http://www.opentopography.org

| AsT =
Mosaic Colormap Mode (optional)
FIRST Ll

Open the toolboxes: Data Management
Tools->Raster->Raster Dataset-
>Mosaic to New Raster.

* Select the files to be mosaicked by
clicking the open folder at the upper
right and progressively select them.

* The Output Location is a directory
(folder) into which the mosaic will go.
* Provide a mosaic name.

* The coordinate system can be
defined by clicking the small button (

) and either Selecting by choosing
the coordinate system into which you
want the mosaic projected, or
Importing which will pull the
projection from an existing file (in this
case, | used one of the DEM tiles) if
you navigate to the file and select it.

* The Pixel Type should be 32 bit
float.

* The other boxes can be left
optional.

* Click OK to launch the mosaicking
process and after a few seconds to
minutes, you will have your mosaic
added to the ArcMap project. Mosaic
both the full feature and the bare earth
DEMs.
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How to visualize the DEM

Color gradients

% Untitled - ArcMap - Ardinfo To visualize the

topography color coded by
elevation (with a different
color ramp than the default

‘ File Edit View Bookmarks Insert Selection Tools Window Help

DSES| L B2@dX |0 || REIYAroE 1=

x|
= £ Layers grayscale), right click on
=@ @ o the DEM file name in the
x -F;emove Table of Contents (left
2 R — portion of the ArcMap
o indow) and choose
bar Joins and Relates > Wi OW
Properties.

<& Zoom To Layer

‘&'2 Zoom To Raster Resolution
Visible Scale Range »

Data 4

Save As Layer File...

o T
|

Choose the symbology tab

File Edit View Bookmarks Insert Selection Tools Window Help

[DE@& v @x o p[maT ] £ @0 W e - [ [Geaere 5 and select the color ramp of

x|

5 £ Layers Interest
R cuiimos|
Value
High : 798.241 Layer Properties (2l

General | Source | Extent | Display Symbology | Fields | Joins & Relates |
Sz Draw raster stretching values along a color ramp Import...

Unique Values
Classified A

Low : 280361
baremos

Color Value  Label

798.2413%4 | High : 798.241
280.361420  [Low : 280.361

http://www.opentopography.org
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Hillshade

Hillshades are a commonly used visualization of topography. They are a simulated reflection of a
light source of specified azimuth and zenith angles from the topography (with set reflective
properties) toward the viewer who is looking straight down.

Untitled - ArcMap - ArcInfi .
To produce the hillshade,
| File Edit |View Bookmarks Insert Selection Tools Window Help f- d
ol you first may need to
= l [m v'jv [ | b |[rar B 1=EaL ’ display the Spatial Analyst
Layout View .
toolbar (View->Toolbars)
ER= Lay Zoom Data [3 .
S| Zoom Layout 4 :
.
F Status Bar Georeferencing
Overflow Annotation Geostatistical Analyst i
7 V] . F.
. E Scrollbars Graphics
% Rulers Labeling
[‘)i- i V Layout
| 7— d Map Cache

Network Analyst
Parcel Construction
Publisher

Data Frame Properties...

Raster Painting
Representation

Route Editing

Schematic

Schematic Editor
Schematic Network Analyst
Spatial Adjustment

Spatial Analyst

F Standard
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| Spatial Analyst ¥ ‘ Layer: Ifullmos ‘ ~ glnzll’);st:‘:_l fl_ﬁéllllg’;;,d Seelect Surface
Distance >
Density...
Interpolate to Raster >
| sufoceanalysis > JECSPN
Cell Statistics... Slope...
Neighborhood Statistics... Aspect...
Zonal Statistics...
Zonal Histogram ... Viewshed...
Reclassify... Cut/Fill...

Raster Calculator...

Convert
Options...
Hillshade M In the Hillshe'tde dialogue box:
* define the input surface (one of
= your DEMs)
Input surface: |fulmos = @] || .+ Select the azimuth (315 is default,
e l 315 but try 45 for some variety as
well)
Altitude: I a5 * specify the altitude (this is the
zenith angle from vertical for the
[V Model shadows simulated light source)
* Choose Model Shadows (this does
Z factor: l 1 a fancier computation which can
be annoying at times in LIDAR
Output cell size: I 0.5 data with small and tall features).
Experiment with this checked and
Output raster: I C:\Users\yamon\Desktop\temp | (= not.
* We don’t usually change the Z
OK Cancel factor or output cell size.
* Provide a file name to make the

hillshade permanent
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Combine color gradient and hillshade into a map

A nice visualization combines the colored elevations semi-transparently over the hillshade.

Make sure that the hillshade is underneath the colored dem (both were produced in the last two
steps).

[ Layer Properties L2 s¥ssRight click on the DEM
file name in the Table of
Contents (left portion of the
ArcMap window) and

General | Source | Extent Display | Symbology | Fields | Joins & Relates

[~ Show Map Tips (uses primary display field)
[ Display raster resolution in table of contents

[~ Allow interactive display for Effects toolbar choose PrOpertieS. Select
Resample during display using: the Dlsplay tab and type 2 5
INearest Neighbor (for discrete data) ﬂ or 50% (dO some
r . . .

Contrast: o | ¢ T experlmentm%) in thg .
Brightness: o % Com [ e 7 transparency box and clic
Transparency: [—50 % Ok.

Display Quality %

isplay Quali -

Coarse  Medium Normal "_

OK I Cancel | Apply |

Switch from the data view to layout view by clicking the small piece of paper shaped button at the

Qa/euﬂ_

1] A~ |‘ Layout View

lower right of the table of contents in ArcMap:
You now will see your view of the map as it would appear on a piece of paper once prlnted
Move the view around with the hand tool and zoom (Tools toolbar).

Add a north arrow (Menu->Insert->North Arrow). Move it and resize it as desired.

Add a scale bar (Menu->Insert->Scale bar [click on properties to change the units if necessary]).
Move it and resize it as desired.

Add a text box and other annotation using the Drawing toolbar.
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Legend Wizard @
~Choose which layers you want to include in your legend
Map Layers: Legend ltems
-~ fullmos > *
-~ fullmosshd —l —l
" baremos

>

(<]
((l

il
3

*

Preview

Set the number of columns in yourlegend: |1 _%'

Back Next > | Cancel |
Legend Wizard @
~Legend Title
Elevation {m)
~Legend Title font properties Title Justification
lor: -
Cotor . | You can use this to
control the justification
Size: |15 v of the title with the rest
of the legend.
Fort: (0] Avial ~|
[6 2] u] [= =] = m|
Preview |
<Back Next > Cancel |

Click through the rest of the screens, leaving the defaults and finish.

http://www.opentopography.org

Add a legend
(explanation): (Menu-
>Insert->Legend). Use the
left pointing arrow to move
all the layers except the
DEM out of the Legend
Items column. Click Next.

Rename it to Elevation (m).
Click Next.

Page 8



Imaging and Analyzing Southern California’s Active Faults with High-Resolution Lidar Topography
A joint SCEC/OpenTopography/UC Davis Keck Caves Short Course

Now you have an Explanation/Legend, but it should be cleaned up: ;

K

Right click on the Legend and choose Properties. Then click Style at the right of Legend
Properties dialogue and then Properties in the Legend Item Selector. Turn off Show Layer Name
and Show Heading in appearance. Click OK back through the dialogues.

in \ |*

1=

@ Alitems (" Selected item(s)
| Apply to the whole item

=

—Map Connection
v Only display layers that are checked on in the Table Of Conter
|V Add a new item to the legend when a new layer is added to

|V Reorder the legend items when the map layers are reordere:I
|~ Scale symbols when a reference scale is set

OK |

;u\euﬂ

http://www.opentopography.org

Legend Item

|~ Shgw Heading

Heading Symboal... |
I~ Ovemide defautt patch
Line: I VI
Area: I vl

[V Show Labels

Label Symbol... |

I Show Descriptions

Description Symbal..

[~ Ovenide default patch size

Width: |36 pt
Height: |24 pt

Only show classes from this heading: IVaIue ;I
[~ Prevent item from being split across legend columns
ok | cancel | ooty |

egend Propertics Legend Item Selector M
Legend lems I Frame I Size and Position I 3 Preview
~ Specify Legend Items saaing Legend E 'u:
Map Layers: Legend Items: — o w“":s
) iI llﬂ S - Description P i 788241
i+ fullmosshd Horizontal Bar with Heading,  Horizontal Single Symbol
.- baremos ﬂ il b 4 Labels, and Description Description Only 3 I Low :280.361
@ Legend Legend
iI ] Layer Name
frecenred | BN b oesovion L
il Columns: r Horizontal Single Symbol ~ Horizontal Single Symbol
Label Only ayer Name and Description
Change text Ex
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We are getting there : : o. To finish off the labeling more cleanly, now go
back to the Table of Contents in the left s1de of the main ArcMap Window and right click on the
DEM and choose Propertles and then the Symbology tab. Edit the labels to be more appropriate.

Layer Properties S B
General | Source | Extent | Display Symbology | Felds | Joins & Relates |
Show:
Uni:ue Values Praw raster stretching values along a color ramp Import... |
-

Classified
Stretched

|~ Display Background Value: I 0 as_|'|
I Usehilshade effect 7. I 1 Display NoData as |-|

Stretch
Type: IStandard Deviations ;] Histograms. ..
n: 2 [~ Invert
— — 2
oK | Cancel | Appy |

H _ — =

E_xport the map as a PDF file if desired for other documents.
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The final map showing the bare earth dataset with the
San Andreas Fault trace clearly cutting from upper
left to lower right..

0 125 250 500 Meters Sanborn Park
| S S S IS S S——
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Slope and slopeshade

Computing the local slope of the DEM is done similarly as hillshade and contours: Spatial
Analyst->Surface Analysis->Slope. Check that the input surface is correct. Usually we compute
slope in Degrees. Don’t change the Z factor or Output cell size. Give the Output raster an
appropriate name and save it with related files.

ISpatiaI Analyst " Layer: Ifullmos

Distance 4

Density...
Interpolate to Raster >

wlin
Surface Analysis > Contour... s Lu
Cell Statistics.. [ siope.. | =
= Input surface: baremos v| [

Neighborhood Statistics... Aspect...
Hillshade... Output measurement: ¢ Degree " Percent

Zonal Statistics...

Zonal Histogram ... Viewshed... Z factor: | 1
- Cut/Fill...
Reclassify... = Output cell size: I 0.5

Raster Calculator... Output raster: IC:\UsersVamon\Deskbop\bemp
Convert »

OK I Cancel |
Options...

The default green to orange color ramp shows the slope distribution well.

Untitled - ArcMap - Arcinfo

File Edit View Bookmarks Insert Selection Tools Window Help

DEE&S * B@dX| o0~ |p[i70s ] || & @ O 3= | K2 || spatiel analyst v | Layer: [fulmos
x g1 TS — ) N == -
= £ layers 3 r e s e .
=0 et

= M baremosslp

[ 0.001382333 - 8137945658
[ 8.137945659 - 15.33567475
[ 15.33567476 - 22.22045911
[[7122.22045912 - 28.16640923
[128.16640924 - 33.17352512
[[7133.17352513 - 38.18064101
[ 38.18064102 - 43.50070165
[ 43.50070166 - 51.01137549
[ 51.0113755 - 79.80229187
fullmos

fullmosshd

baremos

HEHEHH
omOo0O

baremosshd

http://www.opentopography.org Page 12



Imaging and Analyzing Southern California’s Active Faults with High-Resolution Lidar Topography
A joint SCEC/OpenTopography/UC Davis Keck Caves Short Course

Visualizing the landscape as a “slopeshade” can be useful. Your brain treats it similarly as it does
a hillshade, except here it looks as if the illumination comes from all directions. The slopeshade
simply takes the slope map and colors it with steep slopes dark and low slopes white (black to
white inverted color ramp) and stretches the range nonlinearly. Right click on the slope map and
choose Properties. You may get regst to compute unique values

Compute Unique Values

"-"_"\I Unique histogram does not exist. Do you want to compute unique
&Y values?

Yes | No |

Click yes.

An error message about there being too many values may pop up. Click ok. In the Layer
Properties, click the Symbology tab. Choose Stretched for what to Show and then choose a color
ramp that goes black to white with the high slopes being white. Choose “Standard Deviations” -
typically we start with n=5 (default is n=2), but a range of values work depending on what you

want to emphasize. You can also tweak the curve on the histogram page to pull out details in
certain ranges of slope values.
| Layer Properties (D [

General | Source | Bxtent | Display Symbology | Fields | Joins & Relates
Show:

Unique Vakues [Draw raster stretching values along a color ramp Import...
Classified =
Stretched
Color Value Label
79.802292  |High : 79.8023
0.001382  [1ow:0.00138233
coorrore: [ |
[~ Display Background Value: 0 35_"'

7 Usehilshade effect 7. |1 Display NoData as |+

Stretch

Type:

[V Invert

0K | Cancel Aoply |

http://www.opentopography.org Page 13




Imaging and Analyzing Southern California’s Active Faults with High-Resolution Lidar Topography
A joint SCEC/OpenTopography/UC Davis Keck Caves Short Course

Contours
Use Spatial Analyst to compute contours from one of your DEMs: Surface Analysis->Contour.

In the Contour dialogue box (below right), make sure you choose the correct input surface.
Specify the desired contour interval. The base contour should be 0 and keep the Z factor 1. The
process will produce an Arc shapefile. You should save it in the same directory as your other
DEM data.

Contour -
Input surface: Ibaremos LI ‘g
Spatial Analyst ¥ ‘ Layer: Ifullmos 154 ~—Contour definition
®  Distance E = Input height range: Zmin: 281.202728  Zmax: 762.3¢
Density... Contour interval: I 10
Interpolate to Raster » FronarinTE I 0
. —
Surface A > e
| Conto.. 2 oo =
Cell Statistics... Slope...
Neighborhood Statistics Aspect... —Output information based on input contour definition
Zonal Statistics... ﬂillshade... Minimum contour: 290
Zonal Histogram ... Viewshed... Maximum contour: 760
Reclassify... ST Total number of contour values: 48
Raster Calculator...
Output features: C:\Users\ramon\AppDataLocz E"‘l
F Convert >
|4

OK | Cancel I

Options...

To label the contours, right click on the contours shapefile and select Label Features. Usually, the
contours will first be labeled by the feature number and not the elevation. To change the labeling
to elevation, right click on the shapefile and click Properties. Select the Labels tab. Change the
Label field to CONTOURS. Change other characteristics of the label display while you are there

as well. For example, under Placement Properties, you can move the labels onto the contour lines.
Layer Properties M e #:_' ’ - + : »7

General | Source | Selection | Display | Symbology | Fields | Defintion Guery  Labels | Joins & Relates | HTML Popup |

[V Label features in this layer

Method: ILabeI all the features the same way. L]

All features will be labeled using the options specified.

Text Sting

Label Field: D ~| Expression...

Text Symbol
AaBbYyZz
( H- B|I|I_I| Symbol... |
Other Options Pre-defined Label Style
’( Placement Properties... Scale Range... | Label Styles... |
0K I Cancel Apply
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